
 

 

Tutorial: Object Entry Method 

There are now two different methods for entering roofs in Top View. Both methods result in 
roofs that can then be used in the exact same manner; that is, the resulting roofs can all be 
viewed in 3D, estimated, plotted, etc. Note that both methods of entering in roofs can even be 
used within the same project. 

Entering a roof as roof sections is the method you are familiar with if you have used Top View 
before. You can find a series of tutorials in the documentation folder on your CD that describes 
the Add Roof Section method in great detail. In short, the user enters the outline of the roof and 
specifies low areas that result in the generation of planes of the correct slope and orientation. The 
roof outline then clips the planes to define the physical boundaries of the roof. All of the planes 
for these individual roofs are automatically generated from the information that is specified in 
the low area edges. 

Having all the planes automatically generated from the roof outline and low area information, 
instead of having to be entered individually, has both advantages and disadvantages. The 
advantages are that simple roofs can be entered very quickly and automatic detailing can be done 
along all plane edges. The disadvantage is that complex roofs are typically more difficult to 
enter. 

Top View 9.10 provides an alternative to the Add Roof Section method that makes entry of 
complex roofs simpler, especially if you are tracing around an imported DXF or plan image. The 
Object Entry method allows the user to enter each plane of the roof individually. The 
disadvantages of this method are that simple roofs will usually take longer to enter and automatic 
detailing will not be done on plane edges (so each detail will have to be entered manually). Note 
that while it is possible to use the Object Entry method without tracing around an imported DXF 
or plan image, you would need to know all the dimensions of your roof (including hips, ridges, 
valleys and eaves).  

In Object Entry method terminology, a roof consists of a single Group Object containing 
multiple Plane Objects, Cutout Objects and Detail Objects (with each Object being entered 
individually). The estimating information produced by all of the particular Objects will belong to 
their specific owner Group Object. Plane Objects will produce a plane. Cutout Objects will 
produce a void in the plane produced by its owner Plane Object. The length of the Detail Object 
will be computed based on it lying on the plane produced by its owner Plane Object.  
All commands found on the Object Menu are used exclusively with Objects. 

To familiarize you with the Object Entry method, the following tutorial walks you step by step 
through the entry of the roof shown in the file titled ObjectsTutorial1.pdf (which you can find in 
the Documentation folder on the Install CD). 
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1. Click Open Project under the File menu. Enter a project name of OBJECTTUTORIAL 
and click OK. Click OK to accept the default scale and template in the Project Title box. 
Click OK again to accept the Section Defaults. 

2. Next click Import Plan Image under the View menu (or click the appropriate icon) to 
import a plan image. Import ObjectsTutorial1.pdf (which is located in the Documentation 
folder on the Install CD) using a scale of 0.125 in/ft. The imported plan should appear as 
below. 

 

3. We’ll begin by entering the Garage roof. Before you can add a plane you must specify a 
Group, which is just the collection of planes, cutouts and details that make up the roof. 
Click on the Add Object icon, select Group and accept the default template. When the 
Group Object Properties window opens, change the name to Garage and click OK. Notice 
how the Object box at the top of the screen will list all of the objects contained within the 
project (behaving similar to the Section box and its list of roof sections). 

4. The Add Object window reopens. Select Plane. Make sure Ignore Snap Value for First 
Point is selected (this will make your first point as accurate as possible, whereas the 
remaining points will simply be snapped to the current snap value).  Click OK. 

5. Select the bottom left corner of plane A and then trace around plane A, clicking on each 
corner. Note that the Ortho tool can be used to keep the lines straight and the Plan Image 
Window can be used to help select each corner accurately. You can close the plane by 
typing Q (or clicking the right mouse button) and then selecting the closing method 
(which will be Sloped). 



 

 

6. The Plane Object Properties window opens. Name the new plane Plane_A and make sure 
the owner group is Garage. Specify a slope of 4:12. Enter a slope direction of 180 (which 
is downward to the left, noting that slope direction is specified in degrees with 0 being to 
the right, 90 being up, 180 being to the left and 270 being down). Alternatively you can 
press the Specify Slope Direction button and then select the left edge. Specify an 
elevation of 10’ (which is the elevation to the lowest point on the plane). Once you have 
made the changes click OK.  

 

7. Add Object reopens enabling you to enter in the next plane. This time make sure Attach 
is on so that existing points can be attached to when entering in the new plane points. 
Select the top left corner of plane B. Trace around the rest of plane B and close as normal 
(noting that rectangle shapes can be quickly added by simply entering in the first three 
points and then closing with the Right Angle closing method). 

8. The Plane Object Properties window opens as above. Name the new plane Plane_B and 
again ensure the owner group is Garage and the slope is 4:12. Enter a slope direction of 0 
(to the right). Note how there are two ways to specify slope direction and elevation; you 
can enter the information explicitly or use the appropriate Specify button.  For example, 
click Specify Elevation and now select the top right corner of Plane_B and the top left 
corner of Plane_A; this will specify a plane elevation such that these two points are at the 
same elevation. 

9. The Add Object window reopens. Select Cutout, trace around cutout 1 and then close as 
normal. 

10. The Cutout Object Properties window opens. Name the new cutout Cutout_A and ensure 
the owner plane is Plane_B. 



 

 

We've now completed entering the Garage roof using the Object Entry method; note that this 
roof was quite simple and could have quite easily been entered using the Add Roof Section 
method.  We'll now move on to entering the House roof using the Object Entry method 
(noting that the House roof isn't nearly as easy to enter using the Add Roof Section method). 

1. Click the Add Object icon. Select Group. Name this group House. 

2. Add Object reopens. Select Plane. Trace plane C. To trace the sloped lines make 
sure Ortho is turned off.   

3. The Plane Object Properties window opens. Name the new plane Plane_C and 
specify House as the owner group. Enter a slope of 6:12. Specify the appropriate 
slope direction. Enter an elevation of 12’. 

4. Repeat for new planes Plane_D and Plane_E (tracing planes D and E, respectively), 
using Attach and Ortho where applicable. Keep in mind that Specify Elevation can 
be used to set the elevation of a new plane relative to an existing plane by selecting 
corners on both planes that are to be at the same elevation. 

5. When adding new plane Plane_F (by tracing plane F) change the snap value to 1” in 
order to obtain more tracing accuracy; don't forget to change the snap value back to 
12” afterwards. 

6. Add new planes Plane_G and Plane_H (tracing planes G and H, respectively). Make 
sure you specify House as the owner group, a 4:12 slope, the appropriate slope 
direction and the appropriate elevation (using methods previously discussed). 

7. Add new cutout Cutout_B (tracing around cutout 2) ensuring the owner plane is 
Plane_H. 

8. Now we can add the dormer. First we have to put a cutout in the roof where the 
dormer will be located. Click Cutout in the Add Object window. Change the snap 
value to 6” in order to obtain more tracing accuracy. Trace around the dormer 
cutout, which is around the outside edges of planes I and J but using the inside line 
on the right instead of the outside line due to the fact the dormer has a front 
overhang. Name the new cutout Cutout_Dormer and ensure the owner plane is 
Plane_E. 

9. Add new planes Plane_I and Plane_J (tracing planes I and J, respectively). Ensure 
the correct owner group, slope and slope direction. Also make sure to specify the 
correct elevation (which is probably most easily done by matching the outer lower 
corner of the dormer with the inner corner of the dormer cutout). 



 

 

10. Add new cutout Cutout_3 (tracing cutout 3). Ensure the correct owner plane is 
Plane_J.  Note that the snap value can be reset to 12" afterwards. 

At this point we've finished adding the Garage and House roofs using the Object Entry 
method. The 2D and 3D views should be as shown below (you may want to toggle off the 
imported plan image via the Draw command so that the screen is easier to read): 

 

 

 

 



 

 

You can now specify the materials these roof groups are to use. 

1. Select the Garage group (noting that you can select an object by selecting it from the 
Object list, or by clicking on the Object button and then clicking on the object, or by 
simply double clicking on the object until the desired object is selected). Click the 
Object Properties icon, click Materials and then specify 24” metal panels. Do the 
same for the House group. 

2. Click Estimate. Notice that the panels on planes Plane_G and Plane_H don't line up. 
To correct this, select Plane_H, click the Object Properties icon and change partial 
panels to At Right. Click Estimate afterwards to see how the fix has been applied. 

You can now add details to these roof groups.  When adding details it is important to 
specify the correct owner plane so that the detail measurements are computed correctly. To 
illustrate this, let's add an eave detail to the bottom right edge of Plane_F as well as a rake 
detail to the top right edge of Plane_H (noting that these details appear on top of each 
other). 

1. Click Add Object and select Detail. Now select the end points of the bottom right 
eave edge of Plane_F. 

2. The Detail Object Properties window opens. Name the new detail Detail_1 and 
ensure the owner plane is Plane_F. Also select an appropriate eave detail material. 

3. Add new detail Detail_2 in a similar fashion by adding a rake detail to the top right 
edge of Plane_H (ensuring the owner plane is Plane_H). 

Next we’ll add some details to the dormer, specifically an eave detail on the bottom edge of 
Plane_J as well as a sidewall detail on the bottom edge of Cutout_Dormer (noting that these 
details appear on top of each other as well). 

1. Click Add Object and select Detail. Now select the end points of the bottom edge of 
Plane_J. Name the new detail Detail_3 and ensure the owner plane is Plane_J, plus 
select an appropriate eave detail material. 

2. Add new detail Detail_4 in a similar fashion by adding a sidewall detail to the 
bottom edge of Cutout_C (ensuring the owner plane is Plane_E). 

At this point you can finish adding the appropriate details to the remaining hips, valleys, 
ridges, eaves and so on. If necessary, you can also modify all of your existing objects by 
using the commands under the Object menu (noting that these commands are all explained 
in greater depth within the Help).  

The above tutorial briefly describes how roofs can be entered using the Object Entry 
method. For a complex roof, such as the House roof, the Object Entry method provides an 



 

 

alternative method of entering a roof which you may find easier to do than the traditional 
Add Roof Section method. If you would like more assistance with this tutorial or have 
questions about the Object Entry method, please give us a call at 1-800-818-2051 or email 
us at support@asrsoft.com. 

 


